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The purpose of this document is to guide you through the necessary steps to create next year's
payroll. This process includes updating tables and employee information, calculating salaries,
performing edits, and interfacing payroll to Budget. This process occurs in the next year and does
not interfere with the current year processing.

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

ASCENDER - NYR Payroll Process Quick Checklist

| Some of the images and/or examples provided in this document are for informational
£.% % purposes only and may not completely represent your LEA's process.
Prerequisites

Prerequisites:

Gather Beneficial Data:

@ This section is strictly for informational purposes.

Before performing the next year payroll process, review the following tables and gather the data that
will be beneficial while you are updating this information for the new school year.

Proposed/Approved Next Year Salary Schedule

Personnel > Tables > Salaries

Once a salary table is assigned to an employee on the Payroll > Maintenance > Staff Job/Pay Data >
Job Info tab, the table can be updated and salary calculations can be run for all affected employees
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eliminating the need to update the information for each individual employee.

Proposed/Approved Next Year Workday Calendars

Personnel > Tables > Workday Calendars > School Calendar

After receiving the upcoming approved school year calendars, you can create a calendar(s) to assist
with documenting employee workdays and holidays. It is helpful to plan future pay dates and payoff
dates for the next school year in advance.

Reference State Minimum Salary Schedule

Review the TEA Minimum Salary Schedules for changes effective with the new school year.

Accrual Calendar Information

Payroll > Tables > Accrual Calendars > Accrual Calendar

O Creating and assigning an accrual calendar to employees allows you to maintain the accrual
calculations throughout the school year. You can obtain workdays by month information from the
workday calendars.

O Be sure to keep the same accrual codes for each accrual calendar. This method allows for
consistency and eliminates the need to update the information for each individual employee.

O Accounting for the August EQY accrued days in the accrual calendar and using the EQY Payroll
Accruals process assists in properly accounting for accruals across the fiscal years.

Update Next Year Staffing Changes

When payroll opens for the next year, be sure to keep up with the following staffing updates:

e Resignations and new hires: Update the employee status as resignations and new hires are
approved to allow the appropriate budget amounts to be created and interfaced.
o Review TSDS Best Practices for New Employee Records.
o Review TSDS Best Practices for Terminated Employee Records.
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Campus level changes: Update the job table and employment information as jobs move from
one campus to another.

Distribution changes: Update employee distributions based on budget changes.

Update extra duty/stipend pay: Update the extra duty table to reflect changes and
payments. Also, update the balance on the Payroll > Maintenance > Staff Job/Pay Data > Pay
Info tab. The next year payroll budget calculations use the s-type extra duty remaining amount;
therefore, it is important to verify that these amounts have been updated.

Update substitute pay: If substitute pay rates change, update the Personnel > Tables >
Salaries > Substitute tab, which is associated with entering employee substitute leave
transmittals.

Extract Third Party Administrator (benefits) Information

Payroll > Utilities > Employee Benefits Interface > Extract

Perform an extract to create the files containing deductions and demographic data to be sent to the
third-party vendor.

Only deduction codes that have an Extract Ded Cd (extract deduction code) on the Payroll > Tables
> Tax/Deduction > Deduction Code are extracted.

After the new premiums are updated by the third-party administrator and the file is returned, you can
import the updated file making the changes to the next year deductions in one step.

Payroll > Utilities > Employee Benefits Interface > Import Annual File

This utility imports the next year employee benefit choices via a file created by your third-party
vendor. Importing data decreases the amount of time it takes to enter individual employee data
changes.

Manage Employee Change Requests

O Create a form for next year employee change requests. This form assists with data entry and
provides documentation.

O Set a deadline for employee change requests prior to the end of the current school year to allow
time for clarification if needed.

O Update employee direct deposit information. Use caution when updating this information in the
next year frequency as the system will prompt you to update this information in the current year
frequency.

O If your LEA has not already done so, set up the EmployeePortal application. EmployeePortal allows
employees to submit demographic changes and payroll (W-4 and direct deposit) changes. LEA-defined
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options determine what changes can be made by the employee and the necessary approvals.

Before You Begin

Before you begin:
Things to Remember Prior to Beginning NYR Payroll

O Ensure open communication exists between the payroll office and business office.

« Verify that the Budget process is complete and the budget is open.
 Set potential deadlines for various presentations.

O Verify that you are logged on to the current pay frequency.

O Remember: Next year calculations and distributions are validated to the new budget (N). Make
sure that the fiscal year on the distribution pages matches what is in the new budget (N). If it changes
during the process, perform a mass update.

Current and Next Year Shared Pages

The following pages are shared between the current year and next year. Use Caution
when updating these pages in the next year:

Personnel or Payroll > Tables > District HR Options
Personnel > Tables > Credential

Payroll > Tables > Tax/Deductions

Payroll > Tables > Bank Codes

Personnel > Maintenance > Staff Demo (all tabs)
Personnel > Maintenance > Employment Info

Reminders

e New employees must have a Unique ID. Create a Personnel record and copy it to NY Payroll to
ensure that they are included in the Unique ID Extract.

¢ Do not update years of service or leave until Service Records have been created. This usually
occurs between the June and July payrolls and is covered in the Service Record guide.

* Medicare On-Behalf is usually posted to the TRS website in late summer. In most cases, a
reminder is sent by your ESC so you can book actuals to Finance for the year and create a
budget for next year.
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e Remember to update NY Payroll in Budget periodically to ensure that changes are updated. This

allows Budget to remain as current as possible.

Extract IDs

Extract IDs can be used to group similar employees to allow for easier and more accurate mass
updates. For example, most 187-day teachers/aides have the same contract Begin and End Dates,
same Calendar Code, and the same Payoff Date, which may allow them to be grouped together by
extract ID making it easier to select that group of employees when performing Mass Updates.

To use extract IDs:
Personnel > Tables > Job/Contract > Extract ID

O Add or modify extract IDs.

JOB CODES CONTRACT CLASS CONTRACT TERM CONTRALT YEAR EXTRALCT ID TERMIMATION REASDN
Delete Extract id Extract Id Description
B [ A ] [187 EACHERS/ADES |
B [ B | [202 coacHES |
@ [ ] [207 counseLOr/TECH ]
i ( D ] [182 careTERIA |
w ( E | (226 EmPLOYEES |
[ F ]| |256 MAINTENANCE |
B (6] (2205ur secrerary |
B [ n_ ) [imerrEst |
@ | ] [177 PT CUSTODIAN ]
—— )

W

These extract IDs must meet your LEA's criteria so it is important for the Payroll and
Personnel departments to communicate about the setup and use of extract IDs.

Personnel > Maintenance > Employment Info

O After extract IDs are established, assign or modify the extract IDs for each individual employee
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record.

v

Pt Day Emloyed Effective Date: (5555555 |

Directory _J

Employee: 000456 ] [ Retrieve
EMPLOYMENT INFO
Emstoee Stass Employed
Employment Dates Employmient Types
Oiginal Emp Date: Employment Type: [f Falr-Tormee or ‘3
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Payroll > Utilities > Mass Update

O After extract IDs are assigned as needed, select the applicable Extract ID and run the necessary
mass update for a specified group of employees. Extract IDs can also assist in sorting and filtering

report data.
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Pay Campus:
Py Type: [ ~] Certsnt Begn Date
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187 [0 Totat b Experience setmatanConael | [ |

" B Empiloymens Do « | |
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N

Personnel > Reports > User Created Reports

If your LEA uses extract IDs to group employees for mass updates, generate a user-created report to
verify that extract IDs are correctly assigned to employees.
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If extract IDs are missing or need to be changed, you can manually update individual employee
records using the Personnel > Maintenance > Employment Info page.

Next Year Payroll Process

1. Verify August EQY payroll accruals.
Verify August EOY payroll accruals
This step applies to LEAs that included non-accrued employees in the EOQY payroll accrual

process.

O If ASCENDER is used for the EQY payroll accruals, verify that the accrual reversal process was
completed in September 2025.

Log on to Finance file ID 5.

File ID: 5

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry

oo
: % 5 i 3 i & 5 - i Retrieve | Reset
pecoont ode: (195 )1 ()1 (Brio Jif (08 Gous ()1 (¥ (D8 ()8 L :
Dt R Destenill T & o
Crity Dist: ) Pogo: 1ol 65
Processed B Cument (02) B Mot (o) 199 11 6119 ¢ JOO0 X 00 X XK Files I 5
5t Raweniss Rz Fonsordind
Type MNurmbor Db P L Approprialicn Expodiung Balanoe
T8 1 6NMS 00 001 5 17 QO BALARY
** Beginning 00 Q.00 00 oon

G MOVELU  08401-2024 09 OFENING ENTRY -56.504.00 000
GJ  PECE1E 00132024 09 SEP- PAYROLL DISTRIBUTION 411589
Gl P81015 10152024 10 OCT - PAYROLL DISTRIBUTION 4,065 85
Gl PE111S 13182024 11 MOV - PAYROLL DISTRIBUTION 4,065 B
Gl P13 1232024 12 DEC - PAYROLL DISTRIBUTION 436589
Gl PEO1IS 0115225 00 JAN - PAYROLL DISTRIBUTION 418
G PEO2TA 02142025 02 FEB- PAYROLL DISTRIBUTION 436588
Gl PEO3TA 03-14-2025 03 MAR - PAYROLL DISTRIBUTION 4,365 80
Gl PEOMIS 04162025 04 APR- PAYROLL DISTRIBUTION 436588
GJ  PEOSIS 05153025 05 MAY - PAYROLL DISTRIBUTION 4,265 90
G PBOEIY 06122025 06 JUM- PAYROLL DISTRIBLTION 4,235 88
Gl PEOTYS 0F15-2025 07 JUL - PAYROLL DISTRIBUTION 461589
G PEOETS 08152025 08 AUG - PAYROLL DISTRIBUTION 4, 11552

I Gl EOYACT 08-31-2025 08 ALG PAYROLL ACCRLU DISTRIBUITI 4640 72 |

** Ending -56,504.00 000 AT -14656
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o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).

o Click Retrieve.

o Verify that “Payroll Accrual” (or an LEA-defined description) with a positive expenditure
amount was posted (typically in August 2025).

Log on to Finance file ID C.

File ID: C

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry

GENERAL LEDGER INQUIRY GEMERAL LEDGER ACCOUNT SUMMARY EMPLOYEE DISTRIBUTION LEST INQUIRY  OVER EXPENDED ACCOUNT SUMMARY

m Processad E Currgrt, Pericd 09 m PMgxt Perigd 10 E imclissa soft encumbrances whan POs exist G Excluda Obgects 61X G irclude inactive Accounts)
Detcription
Show Datails  Report will display Transaction Detals ”
O--‘w @l‘v‘.l u
Furgd Fung Dy Soby Org Preg

semerse () () ) @B 0 0 (¢ @O @] Lo JL "= |

a9 ‘)
Dabe Run: Detad Trar for
Cnty Dist: 15D Pageciod 4
Processed B Curent (09) B Nemt 10y B 199 11 6119 X0 X000 X X0 X XX Fila I0: C
Est Revenus' Rizd Revsnos

Tyes  Number Dt Par Fsason/Deacription Agpropriation Encumbrance Expandiors Balarce
199 11 B9 00 001 4 11 0 00 SALARIES TEACHERPROFESSIONALS

= Beginning 000 200 00 L]
Gl MmEn L8 DEenms ERTE SassEs o0 1Tl

I Gl REVACC 05052024 09 AUGPAYROLL ADCRLU DISTRIBUTI 8176037 I
- FR L DS THISUTION i

Gl P10 W OCT - PRYROLL DISTRIBUTION 7400527

= Ending 255,852 00 i1 5580005 535 551 54

o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).

o Click Retrieve.

o Verify that “August Payroll Accru” (or an LEA-defined description) reversal entry with a
negative expenditure amount was posted (typically in September 2025).

O If ASCENDER is not used for the EOQY payroll accruals (days worked in August), there is no
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computer journal entry. Verify that the manual JV entries were posted for EOY payroll accruals.

O If a reversal entry is not displayed, use the Payroll > Payroll Processing > EOY Payroll
Accruals page to complete the process.

Year: C Frequency: €

ACCRUALTABLE  DECREMENT  RUN CALCULATIONS  ACCRUAL REPORTS  CREATE GENERALJOURNAL  INTERFACETO FINANCE ~ POSTTOMASTER  REVERSAL FORNON-ACCRUAL  MASS DELETE

Fila 1D: Raversal Interface Transaction Diate:
Accounting Period
> i

(®) Post to Current Acct Period: 10

() Prost to Mewt Acck Period: 11

Select  Frepuency  Calculation Date  Creaste ) Date  interfaceDate  Posted Date  Bewersal bnterface Date
m] F 05312024 05265 2024 0825 2034 05-10-2004

2. Clear next year tables.
Clear next year tables
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES

[ Clear EOY Accrual Data Only [ ] Clear NY Payroll Budget Only

Mo Rows Accrual Calendar
Extra Duty Pay
Haurly / Daily Salary
Job Code

Local Annual Salary
Midpoint Salary
School Calendar

State Minimum Salary
Substitute Salary

Workers' Compensation Rates

Employee Bank Record

Employee Deductions

Employee Extra Duty
Employee Job

Employee Pay

il

gogooooooooooooooooag

Employee Pay Distribution
ECQH Accrual Calendar

EQY Accrual Data

EOY Accrual Fund Decrement

NY Payroll Budget
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If the next year payroll process was used last year and those records were not cleared, use the
following steps to clear the records.

[ Do not select the Clear EOY Accrual Data Only and Clear NY Payroll Budget Only
fields. The EQY accrual data and next year payroll budget data is cleared whether or not these
fields are selected.

O Move all of the tables from the left side to the right side of the page.

O Click Execute.

Notes:

o This process deletes all existing employees from the next year payroll files and a
clean work file is now available allowing you to begin building next year data. In
addition, all tables in all pay frequencies are cleared; therefore, it is only necessary to
perform this process in one pay frequency even if your LEA has multiple pay
frequencies.

o This process can be verified by running the Personnel > Reports > Personnel Reports
> HRS1000 - Roster of Personnel Report for both active and inactive employees with
the next year frequency. The report results should be blank.

3. Copy current year tables.
Copy current year tables
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES l l

Execute Select All Tables
Accrual Calendar I ] [. ]

Extra Duty Pay

Hourly / Daily Salary

Job Code

Midpoint Salary

School Calendar

State Minimum Salary

Substitute Salary

l
[
(
|
Local Annual Salary (
[
[
[
(
l

_,_______,__
(NS I CS B O N N Y O I O [ CS B S T N

Workers' Compensation Rates

O Click Select All Tables to select all current year tables to be copied to the next year. It is
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recommended that all tables are copied so that you have immediate access to any selected
table.

o This process copies all tables (except the school calendar table) for all next year pay
frequencies, regardless of the pay frequency to which you are logged on.

o To copy the school calendar, log on to each pay frequency to do so. The school calendar
is not copied, only the calendar code and the calendar description are copied.

O Click Execute. A separate preview report is displayed for each selected table.

O Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

4. Copy current year staff to next year.
Copy current year staff to next year
Log on to the current pay frequency.

Payroll > Next Year > Copy CYR Staff to NYR

Parameters
Pay Status
| @® Active () inactive () Both | Primary Campus: I"-II v | Payoff Date ‘:E
Pay Campus: | Al bl ] Frequency: & MONTHLY CYR "I
IP"‘" Type: |E Exclude Subistitute b II Contract Begin Date: [ ¥ ] Salary Concept | All vl
v A T %
Job Code: All v | Contract End Date: [ | ExtractID [ v|
Accrusl Code All . ] Contract Months: B Employee MNir I:]!

Prior ¥ Emp Date: | 00-00-0000

Options

| Include Employeses with Termination Date I
U Inactivate Records when Creating WY Tables
D Preview changes
Mext Year's Funding Code D
MNumber of RBemaining Deductions [:]

Copy the employees from the current year payroll to the next year payroll. If you have multiple
pay frequencies, complete this task in all pay frequencies.

Reminder: Be aware of where the budget is in terms of the fiscal year.

What happens?

A complete copy of the current employee record is moved to the next year. Employees can be
inactivated or activated when copying to the next year and those with termination dates can
also be included in the copy process. When copying, you can change the fiscal year in
distribution as well as the remaining deductions in the employee master record. If you update
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the number of remaining deductions, all deductions on the employee Deduction tab are
updated to the designated default value. Be careful of deductions that should not be activated
for the next year and those that the number of remaining deductions should be different from
the default value and perform any necessary cleanup. The Payroll > Utilities > Mass Update
tabs can be used to modify remaining payments for deduction codes.

If this process is performed multiple times for employees without deleting their NYR records, the
system either updates or inserts distribution records from CYR to NYR and cleanup may be
necessary.

Employees in the next year must be active to extract distribution information to Budget. If you
do not activate employees when copying to next year, you can activate them when you perform
a mass update.

O Under Pay Status, select Active to copy only active employees.
O In the Pay Type field, select E Exclude Substitute.
O Under Options:

o Itis recommended to select Include Employees with Termination Date to copy active
employees with a termination date on the Personnel > Maintenance > Employment Info
tab.

o Do not select Inactivate Records when Creating NY Tables.

o In the Next Year's Funding Code field, type the fiscal year to be used when updating
the distribution account code fiscal year in the next year employee master distribution
records.

Leave blank if the distribution account code fiscal year in the next year employee master
distribution record is to remain the same as the current fiscal year until the next year
budget is in place. Then, use the Mass Update utility to update to the correct fiscal year.

o It is recommended that the Number of Remaining Deductions is left blank to copy
deductions with the number of remaining deductions as they exist in the current pay
frequency.

O Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

O Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that
were copied is displayed. Click OK.

O Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

jl

‘ ) Prior to continuing this process, log on to the next year pay frequency.

5. Generate reports to verify employee data.
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Generate reports to verify employee data
Log on to the current pay frequency.
Generate the following reports to assist in verifying employee data.

o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - If an
employee was not copied over to the next year, run the Copy CYR Staff to NYR utility
again for only the single employee.

[ Preview ] [ Z-=IJ- ] [ csv ] [ Clear Options ]
Personnel Reports HRS1000 - Roster of Personnel
HRES1000 - Roster of Personnel y
HRS1050 - Emploves Birthday List oo
HRS1100 - Emplovee Verification Report Parameter Description Value
HRS1200 - Federal EEOC Report .
HRS1250 - Employee Data Listing B ey e e e e 1)
HRS1400 - Teacher Service Record Print Address Primary (P), Alternate (A}
HRS1450 - Ermploves Mailing Labels
HRS1500 - Emplovee Education Repert Select Restriction Local (L), Public (F), orNo restrictions (N) (N |
HRS1550 - New Hire Report E -
HRS1600 - Certification Report Include Primary Job Code? (Y/N)
HRS1650 - Emplo Lary Information :
HRS1700 - Social Security Nymber Verification e L s bl Dk [:
HES1750 - Teacher Incentive Allotment Designation Report Pay Type 1-4, Exclude Subs (E), or blank for ALL [:
Select Pay Campus(es), or blank for ALL : H
Select Pimary Campus(es), or blank for ALL [:] i
Select Extract ID{z), or blank for ALL 1
Select Employes(s). or blank for ALL : b
et Frcuency R
Date Run: Personnal Roster Report Program: HRS1000
Cnity Dist: 18D Page: 10of n
Freguency: F
Emp Nbr Employee Name Employes Address City, State, Zip Primary Campus Telephone
Job Code
000006 ACHIMON, AARON ROXANNE 36911 CR 412 Alamo City, TX 25457 107 - 107 Schoal (555) 586-0643
0178 - WWE REG ED TEACHER
000025 ALFORD, ADRIENNE JOHN 25263 BASTROP STREET Alama City, TX 28178 001 - 001 Schodl
0080 - MHS CTE TEACHER
000040  AMOS, ALEXANDRIA M 124978 FM 331 Alama City. TX 27968 905 - 905 Schod (555) 586-1933
(0662 - EXEC DIR OF OPERATIONS

o Payroll or Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing -
This report can be used to verify deduction information and is available in Personnel or
Payroll. Run the report with only the Include Reports parameter set to Deductions. A
user created report can be created to only include deduction information. It can be sorted
by deduction code and remaining payments.
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[ Preview ] [ PDF I :- csv | Clear Options I
Personnel Reports HRS1250 - Employee Data Listing
HRS1100 - Employves Verification Report -
HES1250 - Employes Data Listing
BS1650 - Emploves S ; Parameter Description Value
Sortby Alpha (A). Pay Campus (C). Primary Campus (P) )
it Reports Setect Fom s :
Include SSN on Report? [Y/M) [r l
Include Number of Days Employed /in Contract on Report? (YN) 1 S
From Last Name |3 letters) l D Personnel
To Last Name (3 Letters) l 8 Payroll
Job
Pay Status Active (4). Inactive (1), or blank for ALL l D TRS
Pay Type 1-4, or blank for ALL l D Calendar ¥TD
Select Pay Campusfes). or blank for ALL ( O schoot 11O
D Leave
Select Primary Campus(es). or blank for ALL I Deduction
Select Extract ID(s). or blank for ALL [ (] Distributicn
Select € 5), or blank for ALL ] €] Pusponskiatty
ect Employee(s). or o 0] Permi
E-mail Subject [
E-mail Message l
l 0K ‘ I Cancel
From Pay Date (MMODYYYY). or blank for ALL C
To Pay Date (MMDDYYYY), or blank for ALL l |
@ 4 P |
Date Run: Employee Data Listing Program: HRS1250
Cnty Dist: ISD Page: 1of 1
Frequency. F
Emp Nbr: 000006  Emp Name: ACHIMON, AARON ROXANNE PEBLEY
Payroll Name & Primary Address Former Name & Alternate Address Primary Campus: 107 - 107 Scheool
Last  ACHIMON Last Payroll Campus: 107 - 107 Scheol
First:  AARON First: Info Restrict A Gender: F - Female
Middle: ROXANNE PEBLEY Middle Rastrict Public:. A Marital Stat: M - Married
Title Gen: Title: Gen: Local Area 1 Birth Date:  07-12-1360
Street: 36911CR412 Street Local Area 2 LastChg:  03-13-201%
City/St: Alame City, TX City/St Drivers Lics: 93658985 T™®
ZipCd: 25497 ZpCd DL Expir Date: Deceased: N
Country. TRS Beg. Dt 11-01-2000 SSN 256-66-3799
Phone: (555)586-0643 Cell ( ) BusPh () Bus BExt Citizen: Y
\wk E-mail: Hm E-mail Hispanic/Latino [ Black/African American O
Supplemental Acgess Asian (] Amenican Indian/Alaskan Native [
OB hite B Native Hawaian Other Pacific sl )
Emergency Contact Relation Bilingual
Phone: Ext
Emergency Notes
Deductions
Emplr  Remain Cafe Emplr TEA
Deduction Code Net Amount Contib  Pymts Refund 125 Factor Factor
001 - ADDITIONAL 300.00 00 99 N N 1 1
025 - ACTIVE CARE PRIMARY (11] 51400 99 N Y 1 1
054 - GROUP (DISTRICT PAID 00 & 9 N N 1 1
100 - TPA EXTRACT FILE 00 00 0 N N 1 1

o Payroll or Personnel > Reports > Personnel Reports > HRS1100 - Employee Verification
Report - This report provides detailed employee data such as employment dates, salary,
address, and other information for reference or to verify recent input and processing.
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’ Preview ] ’ PDF ] ’ [Ty ] ’ Clear Oplions ]
Personnel Reports HRS1100 - Employes Verification Report:
HES1100 - Employes Verilication Report
HRE1250 - Employee Data Listi P
HRS1650 - Emgloyee Salary Infommation Parameter Description Valle
Sort oy Alh A). Py Compus €. Pray Cas
Select Restriction Local (L), Public (P), or No restrictions. (N)
Pimary Job (P, or blank for ALL )
Pay Status Active (&), Inactive (1), or blank for ALL
Pay Type 1-4, Exclude Subs [E), or blank for SLL
Salect Pay Carmpus|es), er blank lor ALL 1
Select Primary Campusies), or blank for ALL :} i
Satect Extract IDfs), o blank for ALL 1 :
Select Employes(s), er blank for ALL A
Date Run: Employes Verificalion Report Program: HRS1100
Gty Dist: 1SD Page:3of 9
Frequency: &
Emp Nbr  Employee Name Emp Date Emp Status Pay Status Job Code
Sex Address Term Date  Term Reason Cred Yr Svc Pay Campus Primary Campus
City State Zip Pro Yrs Exp MNon-Pro Yrs Exp ExtLvBeg  Payoff Date “%Day Empl St Step GRDILVL /Sched
Birth Date Telephone In Dist In Dist Ext Lv End TRS Beg Date  Annual Sal Pay Type Pay Rate
000060 SMITH, BARBARA GALE 08-16-2001 2 - Active auxillary per 1 = Active 0428 - PHYSICAL EDUCATION
F PO BOX 555 (m] 999 - District Wide 735 - CAFETERIA
ANYWHERE TX 76809 o 14 08-25-2022 100% SPA / 114
03-01-1962 o 14 03-01-2009 33,702.00 2 2,808.50
000082 SMITH, BECKY R 07-01-2004 1 - Active professional 1 - Active 0115 - BUSINESS MANAGER
F 2810 SNICKERS ROAD O 750 - BUSINESS 750 - BUSINESS
ANYWHERE TX 75661 17 o1 06-24-2022 100% 17 ! !
09-11-1952 17 1] 09-29-2004 116,000.00 1 9,666.67
000131 SMITH, BRENDA K 08-11-2005 2 - Active auillary per 1 - Active 0721 - CAFETERIA FULL TIME
F 5854 LIBERTY BELL RD O 735 - CAFETERIA T35 - CAFETERIA
ANYWHERE TX 758657 o 33 08-25-2022 100% CAF / i
01-24-1950 o 14 08-15-2006 15,346.80 3 14.21
000104 SMITH, CAROLYN M 08-09-2004 1 - Active professional 1 - Active 0638 - JR & SR HIGH TEACHER
F 42956 ROSEBEOROUGH RD O 002 - ANWHERE HIGH 002 - ANWHERE HIGH SCHOOL|
ANYWHERE TX 75672 18 [} 08-25-2022 100% 17 TR1 { 18/

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. The
report can be sorted by name, campus, or extra duty code. The Include Distribution
Account Codes parameter includes S-type distributions for the selected employees.

e J[ v [ o || sextens |

Payroll Information Reports HRSE550 - Employee Extra Duty Report
HRES132 m| L ata Listin -
HRS1450 - Employes Mailing Labels

S 1660 - Emploves Salary Indorrmation

HRS52 04 Form:
HRSSIES - 1095-C Forms
HESE300 - Emploves Permit Data Inelude Distribution Account Cades? (1M
HES5350 - Emploves Responsibaity Data
HRSEA00 - Salary Verification Roport Pay Status Active (A}, Inactive (1), or blank for ALL
HESEAG0 - Health Insurance Coverage
HESES00 - Campys Intormation Pay Type L-4, Exclude Subs (E), or blank for ALL
HRES6550 - Employes Extra Duty Report
HESEE00 - Campus improvement Plan Exip FTE Report Sclect Pay Campusies). or blank for ALL

HESE700 - Health Insurance Status Regort Select Primary Campus(es), or Blank for ALL : i

Parameter Description Value

Sort by Alpha [A). Pay Campus (), Primary Campus (P}, Extra Duty Code (E)

HRESE T AL 1 YTD Regort
Sclect Extra Duty Code(s). or blank for ALL

Sedect Efmnplayes{s), or blamk far ALL
Page Broak by Extra Duty Code (Y/N) (Reguined when selecting Sart by Extra Duty Coda)

Select Frequency
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Date Run: Employee Exira Duty Report Program: HRSG6550
Cnity Dist: ISD Page: 1of B
Frequency: F
Extra Duty Code Typ Amount Remain Amt  Remain Pymts
Emp Nbr Employse Name Account Code Job Acct Amit Acct Percent  Grant E Perf Pay Activity Code
000006 ACHIMON, AARON ROXANMNE 04 G 1.000.00 1] 0
000025 ALFORD, ADRIENNE JOHN 03 G 3.000.00 oo 0
04 G 1.000.00 ] 0
09 G 3.500.00 00 0
28 G 7.700.00 oo 0
42 G 1.000.00 ] 0
Total for ALFORD, ADRIENNE JOHN 16,200.00 .00

6. Update employee credentials.
Update employee credentials
Log on to the current pay frequency.
Personnel > Tables > Credential

Update the Credential tabs as needed. This information is used to maintain teacher credentials,
is usually done by the personnel department and does not affect salary calculations.

The Credential tabs are shared between the current year and next year records; therefore,
changes to the current year records are effective in the next year records, and vice versa.

Note: The Teaching Specialization tab is used to report Pre-K teachers for Class Roster so if
there have been changes, you can make those updates now in anticipation of the
submission.

MAJOR / MINOR COLLEGE CODE CERTIFICATION TYPE SPECIALTY AREA TEACHING SPECIALIZATION SERVICE RECORD NOTES

[¢]

Personnel > Tables > Credential > Major/Minor

Personnel > Tables > Credential > College Code
Personnel > Tables > Credential > Certification Type
Personnel > Tables > Credential > Specialty Area
Personnel > Tables > Credential > Teaching Specialization
Personnel > Tables > Credential > Service Record Notes

[¢]

[¢]

[¢]

o

[¢]

7. Update next year salary tables.
Update next year salary tables
Personnel > Tables > Salaries NYR

Update the following next year salary tables to reflect any changes to the salary schedules
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(anticipated or known).

These tables are not shared between the current year and next year records.

LOCAL ANMUAL HOURLY/DAILY EXTRA DUTY STATE MIN SUBSTITUTE MIDPOINT WORKERS' COMP

Personnel > Tables > Salaries NYR > Local Annual

This tab is the most commonly used. You can make mass updates by percent or dollar amount,
or by employee. To see a change before saving the record, enter the change and click Default.
The original annual amount is displayed in the Annual Amt column, the percent or dollar is
increased, and the New Amount is displayed. Click Save. If decreasing a salary, enter a
negative percent or dollar amount.

On the Personnel > Tables > Job/Contract > Job Codes tab, this salary concept can be attached
to the applicable job(s). When the job is selected on the Job Info tab, the system populates the
Base Annual field automatically in the Daily Rate section on that page and can calculate the
daily rate based on the number of days employed. In addition, when the Mass Update Salary
Calculations feature is used, the system uses this table to extract the correct salary information,
perform calculations, and populate many fields on the Job Info tab.
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Save

LOCAL ANNUAL  HOURLYDAILY  EXTRADUTY  STATEMIN - SUBSTITUTE MIDPOINT  WORKERS' COMP

Racorgs Mesdify Salary

Pay -;_r.-.m (® By Porcent nmum__* [ Detault l [ Print
Pay Step {0 By Dollar Amt
Delete Pay Grage Pay Step Mux Doy Emplonetd  Logsl Schad  Anous| Ay % Increade New Amgyet
B a0 0 o0 1N v I e e | ooa © [ 1a37000]
B [ aw J[ o ] [ 1w ] | | o0 ooo] [ tarrona)
B [ aw J[ o2 || [ e ] | | 1simoo0 oo0] [ 1siraoo)
@ [aw J[ e ] [ e | | | ssam ooo] [ 1557000
W [ aw J[ e || [ 187 ] | ] iseram0 ooa] [ 1s97000)
B [ aw [ s ] [ mw ] | | =AM00 [ 0.00) [ 16370.00)
B [ a0 J[ e | [ e ] | L | voo] [ terrono)
@ [aw J[ o ] [ e | | ] aamem ooo] [ 17.a7000)
@ [ aw [ e ] [ 1w | [ I E | ooa] [ 1757000
B [ aw J[ = ) [ 1w ] | ] 1787000 [ 0.00) [ 17970000
8@ a0 J[C ) C e ] [ ] 80 o00) [ 1877000
W [aw J[ 1z ) [ 1w ] | ] 1w ( 0.00) [ 1917000
@ [ aw [ 1= ) [ 1w ] | ] 1857000 [ 0.00) [ 1957000)
B [ aw J[ = ) [ 1w ] | ] 1887000 [ 0.00] [ 1ss7000]
B Caw [ il EETEm | e | oo0)] [ 2027000

Personnel > Tables > Salaries NYR > Hourly/Daily

The Hourly/Daily and Midpoint tabs can be updated in the same way if used by your LEA.
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LOCAL ANNUAL  HOURLYDWAAY  EXTRADUTY  STATEMIN  SUBSTITUTE  MIDPOINT  WORKERS COMP
Aeconds Moty Salary
Pary l:-ul:-.' E @ B Porcens T l Dot ] | g
PaySeeps (Al w] ) By Drollar Aot
() Fram Seate M
Delee B Grads Eire Sign HriPer Doy Bate Tvoe  Locsd Sched By Tep: EstOvimbrs  Amount % bcreass e At
| s iareml o | I ~] [ epo.o] QRS Y vooo] [ 12830]
B [mr [t | [Csee ] Mewir | ] «] [ Boop] 1283 [ nom) 1283
B [Tw J [ [ oo | Heww 1 w| [ gonn] | ERT [ 0,000 [ 17s30]
® [ e J[ 1 | [ see | Hewtv | ] ~] | goop)  12E30 [ 0.000] [ 12.630]
B | [Twr [ 1z [ s || My 1 w] [ spoo] PR [ 0,000 [ 13E30]
B e | 3 ) [ Bom ]| Hewlv | ][ «] | B00.0) LE30 [ 0.000] [ 1zam]
@ Teor | [ 1@ I seo ]| Hesed | g w] [ aoop)  A2E30 [ 0.000] [ 12830
B [w1 J[ 158 [ 800 ] How | ][ v [ goon)|  LIEN [ 0000 [ 128m]
B [Teor J[ 1 ][ see ]| R | 11 w| [ Bogp  HEEI0 [ 0.000) | 12.830]
P [Cwn [ w [ s ] Hemy [ ][ v [ soop)  1EE30 [ 0.000] [ 12830]
B o [ ) [Csw | B ) | W awy) w0 (o) [_um)

Save
LOCAL ANNUAL  HOURLYDAILY  EXTRADUTY  STATEMIN  SUBSTITUTE  MIDPQINT  WORKERS' COMP
Recoeds Modify Salary
PayActe: [an w @ By Pescent aenount]_0.00) % [- e ] [ i ]
whally Sep{al v ] (O By Dollar &mt
e §
Delete Loge Descrigtion Agcoust Code Agtivity Wholly 360 Exp 373
& [l [rEcrmowocy aoe ] [[199-11-6129.00-001-%-31-0-] 27 [[B0 Base Satary v F[Hre v ¥ account used in 458
@ [ COUNSELOR MASTER ][00 A0 H--8] 3 [79 Other Supplemental w]  [WMo w] (¥ Account used in ASB
& [coscHING ]  [199-36-6119.00-001-%-91-0-] § |02 UIL Athletics v] [HMow]  [¥ Account used in ASE
(I [MA SUPPLENMENT ] [re-de-dooocon-Ra-K0ex] o [20 Base Salary w] [MMow] [¥ Account used in ASE
1 [cHEER sPonsoR ] [re9-3s-e11901-001-%x-91-0-] 3 [18UL Cwbsiaciviies w]  [MMe w]  [¥ Account used in acst—:.<:
& [aT STIPEND ] [199-35-6119.00-001-%-99-0-] ; [05BandorOmnestra  w] [WMew]  [¥ Account used in --:\&<
o [&THLETIC DWRECT. ] [r99-35-6119.00-001-%-91-0-] 3  [0Z WL athletics v]  [HMew]  [¥ account used in ASE ()
T [MATH/SCIENCE SUP ] [R-soooi - Ror-ii-s] 3 [79 Other Supplemental ] [MMo w] ¥ decount used in ASB
& [BAKD STIPEND ] [-s-0000N-300-000] 3 [05 Bandor Orchestra w ] [MBo w] [ ¥ Account used in =7
] [sTasR CORE ] [ESS-a0000dn-inena0ex] ¢ [16 UL Cubsiactivites w]  [M Mo w] [V Account used in ASE
w 'El [sramisH STIPEND ] [22%-1i-e119.00-001-%-0cx-] § |80 Base Salary w| [MEow] ["A:ccuntmm:ni‘.i&-t._
] [REC. STFEND | [exoxxouoedex-mxx-ddx] 3 [80 Base Salary w| [MMew] ¥ Account used in ASE
i [rearBoGK | [ - oo K-xx-8] 3 [79 Other Supplemental ] [MNe w] (¥ Account used in 858 "
' ,

Personnel > Tables > Salaries NYR > State Min
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This tab is updated via a file upload when applicable. These instructions are sent separately
with the file as needed.

Personnel > Tables > Salaries NYR > Substitute

This tab can be manually updated as needed.

LOCAL ANHUAL HOURLY DALY EXTRA DUTY STATE b SUBSTITUTE MIDPOINT WORKERS' COMP
Reconds Modity Salary
R T |
Time: of Doy Al w| ) By Dullar Asnt
& FEGULAR SUBSTITUTE I A ] [FuLL cwr I oo JI 10 | 000 90.00
o REGUILAR SUBSTITUTE [ & | [merow ] [ asea ] | ] o
®  [o2occnew) DEGREED SUBSTITUTE = | [Foosr ] [ 1o | | ] 9200
o DEGREED SUBSTITUTE 8 ) [rarow ] [ oseo | | ] A.50
1 CERTIFIED TEACHER SUBSTITUTE [ . ] [FoLoar [ wwe ) [ ] loooa
- CERTIFIED TEACHER SUBSTITUTE [ B ] [FeAroar ] [ osee ) [ ] .00

Personnel > Tables > Salaries NYR > Midpoint

Payroll > Tables > Tax/Deductions > Workers' Comp

8. Update job code table.

Update job code table

Personnel > Tables > Job/Contract NYR > Job Codes

Add or update job codes as needed.

The job codes table is NOT shared between the current year and next year records.
e e i W

JOB CODES

| Retriewe J [ Print J

) [ oooo | [ceneric D v [ - | 3 [Auseasnnual satary table  +|
[(0001 ] [HIGH SCHOOL TEACHER ][ ~ [ - ] § [Auseannuatsalary table ]
) [ o002 | [TEACHER/COACH N vl [-- - ---- ] § [AUseannualsalary table |

O Select the appropriate Salary Concept for each job.
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O (Optional) Update the distribution Account Code fields.

Notes:

o In the FTE Hrs field, type the appropriate full-time hours for each job code. Effective
September 2017, the scheduled weekly hours are used by TRS reporting.

o You can assign accrual codes, Workers’ Comp codes, and FTE hours to lessen the
workload when completing tabs for new employees.

9. Create calendars.
Create calendars
Personnel > Tables > Workday Calendars > School Calendar

Only complete this step if it is applicable to your LEA. All LEAs must create a TR calendar.

Selected Calenda Code: TR TR CALENDAR - Freguency: F

August 2026 September 2026 Movemnmber 2026

Su Mo Tu We Th Fr S5a Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa

December 2026 Janary 2027 February 2027

Su Mo Tu We Th Fr Sa

i

Mo Tu We Th Fr Sa Su Mo TuWe Th B Sa
] 1. 2 4

dpril 2027 May 2027 June 2027
Su Mo Tu We Th Fr Sa Su Mo Tu We Th B 53 S Mo Tu We Th 1 53
W - 5 e

Workday 260

Q
L]
5

=3

0
Bad Weather Diay 0
Total Days: 365

Create school calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Number of Days Employed field if the beginning and ending contract dates are
entered. Additionally, using a calendar can provide an easier way to manage payoffs and verify
your accrual days.

Notes:

o Calendars tied to a numeric frequency (e.g., 6) are used for current year.

o Calendars tied to an alpha frequency (e.g., F) are used for next year. Use the
spyglass to create or edit calendars as needed.

o You can copy calendars that begin in the same month. Example: If you create the
10-month calendar beginning in August for teachers for 187 days, you can copy the
calendar to the Food Service and Bus Driving calendar codes, and then edit them to
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reflect the differences such as begin dates and holidays.

O Create calendars with the same calendar code as the current year to avoid having to update
the calendar code on the individual employee's job info record.

O Select the calendar to be updated.

o F E [LBRARY AIDE/CAFE |
o 3 EE [BuzBEE |
o F F [caFETERIA ]
o F G [GIRLS HEAD BB COACH ]
o] F H [BUS |
0 F | [careTERIA MGR |
fo) F ) (VO AG AIDE )
o] f K [HouRLY |
D F L [PRINCIPALS |
o] 3 M (a0 ]
o F H [MEDFORD |
D F 0 [SUPERINTENDENT |
o F P [PEUGH |
o F Q [voac2 ]
o F R [BUSINESS MANAGER |
o F s (ELem counsELor ]
o F s [SUMMER SCHOOL |
o] F 55 [sumMmER scHoOL |
o] F TR [TRcaLENDAR ] g
Add
Start Year (YYYY) 2026 |

Start Month (MM] S |

Set Calendar «

Start Year |Type the starting calendar year in the YYYY format.
Start Month|Type the starting calendar month in the MM format (e.g., 07 for July).

O Click Set Calendar to display the calendar. The calendar is rearranged to begin with the
entered starting month.
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It is recommended that you build the calendar with the greatest number of days
worked first, and then use the Copy School Calendar tab to build other calendars

© by ma

king modifications to the original.

IMPORTANT:

o For TRS purposes, a TR calendar with a calendar code of TR must be created

for all available workdays beginning 09/01. (TIP: If 9/01 falls on a weekend
day, select the first working day of the month.) The TR calendar is used to

populate the number of days worked on the RP report for employees who are

not assigned to a school calendar

o For TRS purposes, ASCENDER submits retirees' contract days one month at a
time. This allows maintenance on the reporting of half time or full time from

month to month on retirees.

10. Update staff demographic data.

Update staff

Personnel > Maintenance > Staff Demo > Demographic

demographic data

O Add new employees or update existing employees. Refer to the ASCENDER - New Employee
Setup guide for additional information about adding new employees.

The Staff Demo information is shared between the current year and next year records;
therefore, changes to the current year records are effective in the next year records and vice

versa.
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Employec: (00000 : ADAMS, ADEME. ] [ Retricve ] [ Directary ] [ 4ictel Eman ] [ Ciacumants ]

DEMOGRAPHIC INFORMATION CREDENTIALS WERIFICATION INSEURANCE SERVICE RECORD RESPONSIBILITY

Seaff IDVSSM:  110-26-2035 Tewas Unique Staff ID: [:] Last Change:  06-11-2008
Name
Legat [ W] [2DaM ] [E ] [eDams ][ ] ]
Masden Name
Farmer: [ V] [ ] [ ] [ ] [ V]
Titie First Mickdi= Last Generation
Addresses
Bsmber StreetPO. Box Apt City State Zip s
Mailing [ ] [Foeoxids ] [ ] [Alame Gry ] [T Teas NI | ]
Aliemate: [ ]I ] | ][ ~] |
Address Cosntry Dielivery Mame

Supplemental [ ] [ ] [ ]

Travel Commute Distance:

Remember: All employees must have a TX Unique ID number. The TX Unique ID number can
be extracted on the Personnel > Utilities > Texas Unique Staff ID Interface > Staff ID Export

tab.

STAFF ID EXPORT  STAFF ID IMPORT

School Year;

From: 2025 To:

Execute J

O Save the file and forward it to your District PEIMS Coordinator to be processed.

STAFF ID EXPORT STAFF ID IMPORT

Import File:

File Mame

[ mowse. | | Execue
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11. Update employment info.
Update employment info
Personnel
Add or update employee information.

Personnel > Maintenance > Employment Info - This tab is shared between the current year and
next year records; therefore, changes to the current year records are effective in the next year
records and vice versa.

O Select the NY Take Retiree Surcharge field to include the retiree surcharge when the
Extract Payroll to Budget process is performed.

Note: If service records have not been created, do not update data such as the Percent
Day Employed, Years Experience and Grade(s) Taught fields for existing employees.

Terminated Employees

It is best practice to not only update the Termination Date and Reason but, if applicable,
update the Auxiliary Role ID and Paraprofessional Certification End Date.
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Save
Employee: (000001 : ] Retrie J [ Directory
EMPLOYMENT INFO
Employee Status Not Employed
Employiment Dites Emplayiment Types Retires Information
Original Emp Date: Employment VR ['F Half-Time or mare ~] Fetrement Data:
Latest Re-Empioy Date: Subs Typo: [ ) Retiree Employment Type: ( ~]
Termanation Duate: Highty Qualified: D Take Retinge Sunchange: D
Extract for TS0S D Year Roynd: D MY Take Retiree Surcharge: D
Termination Reason Extract I0: [ v]
Eligitde for Re-hire 0 Highs:st Degree:
i tc—
Percent Day Employed:
Pet Day Employed Effective Date: (7550 5000
Years Experierce Electromic Consent Service Record Contract Information Extended Leave
—Professicnal-- --Men-Prafessianal -- Wk [:] Full Semester: Class: [ ‘..] Begin
W O e gy o). | Eemanr Y | o ( 2 |
In District: D In Digtrict: ear: [ )
Price Teaching: @
Creditable Year of Service: D
TRA Years Experience Muiliary Role ID Paraprofessional Certification
TRA Teaching Experience: E
TRAE O Delete  Aspdliary Rele 1D Begin Date End Diate: Delete  Para Cert  Begin Date End Date
ligibility: - .
8 | 0 | e | e T [ o

Personnel > Maintenance > Staff Demo > Responsibility

In addition, update the End Date on the employee's responsibility record.
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Save

Employee: EW{I‘DDJ,: ] [ Retrieve J [ Directory J

DEMOGRAPHIC INFORMATION CREDENTAALS ~ WVERIFICATION INSURANCE SERVICE RECORD RESPONSIBILITY

Delete Details Year Campus Staff Classification Staff Service
o O

g

School Year for PEIMS Codes: 2026
lob Code: (0426 TEACHER'S AIDE ] Staff Service: [5A000003 - Instructional Educational Aide | 3
Campus: SPED Student Age Range: |01 Age 3 Through & (ot KG) )
Co-op/SSA LEA: :] Pop Served: (01 Regular Students v
Staff Classification: 033 - Educational Aide ]:  Monthly Minutes:
ESC/SSA: [School District Employee ~] # of Students: [I]

g One

| Enc Date: [05-18-2026] I

12. Update tax/deductions.
Update tax/deductions
Log on to the next year pay frequency.
Payroll > Tables > Tax/Deductions > FICA Tax

Retrieve the FICA rates for the 2026 calendar year and print a copy for reference. Then, retrieve
the 2027 calendar year record and manually enter the 2026 rates for 2027 and click Save.

6 CAUTION: Be sure to retrieve the 2027 year record prior to updating this tab.
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catondervaar: (026 )| [ review | [

EXEMPTIONS  INCOME TAX UNEMPLOYMENT  TRSRATES ~ ANNUITY RATES  WORKERS COMP  DEDUCTION CD

| Pring

FICA Max Salary:

Emplayes FICA fate [ 620% Employes FICA Max Tax: 11.239.00

Emplover FICA Rase [ 520%] Employes FCA Max Tax 11.439.00

Modicare Rate: Additional Medscane Rate: MAdditional Medicare Salary Threshaold:

HEA Max Employis Contribution

lmmmr. I Retrievs ]I Dolet _J
EXEMPTIONS  INCOME TAX UNEMPLOYMENT ~ TRERATES  ANNUMYRATES  WORKERS' COMP  DEDUCTION CD
| |

Payroll > Tables > Tax/Deductions > Unemployment

If your LEA allows ASCENDER to calculate unemployment, select T - Taxable in the Employer
Type field and enter the Unemployment Rate. Type the percent rate determined or assigned by
the TWC (e.g., 0.4985% for 0.004985).

The rates displayed in the below image are sample rates. Only use the rates provided by the
Texas Workforce Commission (TWC).

EXEMPTIONS INCOME TAX [FICA TX UNEMPLOYMENT THS RATES ANKUITY RATES WORKERS' COMP DEDUCTION CD

Prinst

Payroll > Tables > Tax/Deductions > TRS Rates

Update the TRS rates.

6 CAUTION: Be sure to retrieve the 2027 data prior to updating this tab.
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IMPORTANT: Be sure to visit the following TRS websites:
https://www.trs.texas.gov/Pages/re_contribution_rates.aspx and

& https://www.trs.texas.gov/Pages/re_salary _cap_provision.aspx to obtain the
updated rates for the next school year, and then return to this table to update the
new rates.

Note: The below image displays the TRS rates for the 2025-2026 calendar year. This image
will be updated to reflect the TRS rates for the 2026-2027 calendar year as soon as they
are published.

School Year: | 1037

EXEMPTIONS INCOME TAX FICA TAX UNEMPLOVMENT TRS RATES

CAUTION: Be sure to type the new
school year and click Retrieve

before entering the updated rates.
!

TRE Rate Masnbios Ritisgamenl Contiduatica W
TRS ndurance Membor Carg Contribution [ 0.65%) Emplayer Paid M|
District Rate S Contribution B.250%)]
TRS Care Rate Fodoral TRS Care: ( 1.25%)
TRS Care Empls Contrib RE TRS Care Cantribution [ orw
TRS 5 Satary Cap [ 300009

THRS Neon-OASDI Rate  Public Education Employer Contribution (PEEC) 2.000%]

O To create a new TRS rates record, type the new year (2027) and click Retrieve. A message is
displayed indicating that the new record is populated based on the prior year's (2026) TRS rates
record, click Save to retain the record.

O Complete the applicable fields. This information is used when performing calculations and
extracts to Budget.

Payroll > Tables > Tax/Deductions > Deduction Code
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| Year: C

EXEMPTIONS  INCOME TAX FICATAX UNEMPLOYMENT  TRSRATES  ANMUITY RATES  WORKERS COMP  DEDUCTION €D

7] [ADDmIONAL WITHHOLDING TAx ]| [wH A O O | ] O
= ) o= ~ 0 O [ T
[GavinGS BONDS ) [585aving v] [SAViNGS BON | (] O [ ] : :] (]

O Update the deduction codes. The Deduction Code tab is shared between the current year and
next year records; therefore, changes to the current year records are effective in the next year
records, and vice versa.

13. (Optional) Update accrual calendars.
(Optional) Update accrual calendars
Payroll > Tables > Accrual Calendars > Accrual Calendar
Log on to the next year pay frequency.
This step is for LEAs that perform monthly accruals.

Create accrual calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Accrual Rate when the calendar code is entered in the Accrual Info section.

Save Yoar: H Frequency: F
ACCRUAL CALENDAR
He
Delete Detalls  Accrual Code  Total Duvs Worked Delete Py Date Dares Weorkesd
@ o A sl B  [os-3r2026 ) | 12.00|
i [e] B a0
[} c 00 [o9-19-2026 | | 20.00]
o - L] B [10-20-2026 2200
o g i [10-20-2026 | | |
o E a0 [12-14-2026 | | 17.00)
o G a0 T -
o : oo [12-19-2026 | | 15.00]
ror (] i O

Verify that the calendar code reflects the actual number of days the employee will work for the
new school year; otherwise, the salary amount that should accrue over the school year will be
incorrect.

o You can use the school calendar created in the previous step to get the actual workdays
by month.

o If you have not set up the budget for the 2026-2027 school year, you can only enter pay
dates through the 2026 calendar year. If the budget is set up for the 2026-2027 school
year, you can enter 2027 pay dates in these fields.
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Notes:

o This table can be updated after the move to current. All pay dates should be entered
even if zero days are accrued (e.g., summer months).

o Most districts only accrue 10-month employees. If that is true for you, each code
should begin with August 31 and show the number of days that group of employees
will work in August. Add 12 more lines and enter the true/regular Pay Dates. Enter the
days employees work in the month associated with each pay date.

o Typically, July and August (and sometimes June) will show the pay date and zero
days, but they still must be included.

o Dates used (with the exception of August 31) must match the Pay Dates that will be
built in the Pay Date Table.

14. (If applicable) Mass update employer contribution and remaining payments.

(If applicable) Mass update employer contribution and remaining
payments

Log on to the next year pay frequency.

Use the Mass Update utility to update employee data in preparation for the new school year.
This utility allows you to quickly and easily mass change data resulting in minimal manual
changes to individual employee records with less possibility of manual entry errors.

pay frequency to which you are logged on as you may be changing back and forth

0 CAUTION: To avoid entering data in an incorrect pay frequency, be mindful of the
between the current year and next year's pay frequencies for several months.

If applicable, mass update the Employer Contribution and Remaining Payments for all
employees with health care and other employer paid deductions.

It is recommended to update the number of remaining payments for deductions to ensure
they are fully budgeted for.

Payroll > Utilities > Mass Update > Deductions

This utility is used to update deductions for a number of employees at a single time.
Deduction data may be updated by a variety of criteria including pay type, pay grade,
primary campus, and pay frequency. The Deductions tab allows users to add, change, and
delete deduction codes as well as alter the number of remaining payments and the existing
dollar amounts associated with the deductions. Mass deduction updates are very useful at
the beginning of the year when many employees are being added to insurance programs.
Once deductions are added using this tab, they are reflected in the individual deduction
records.
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O Under Parameters, select the employees whose deduction data is to be changed.
TIP: Prior to processing a mass update, capture a screenshot of the parameters used for future
reference.

O Under Method, select the type of deduction change to be implemented.
O Click Execute. A preview report is displayed. Review the report.

O Click Process to accept the changes and continue. Or, click Cancel to return to the Mass
Update page.

15. Mass update pay and state step fields.
Mass update pay and state step fields
Log on to the next year pay frequency.

Use the Mass Update utility to update employee data in preparation for the new school year.
This utility allows you to quickly and easily mass change data resulting in minimal manual
changes to individual employee records with less possibility of manual entry errors.

pay frequency to which you are logged on as you may be changing back and forth

0 CAUTION: To avoid entering data in an incorrect pay frequency, be mindful of the
between the current year and next year's pay frequencies for several months.

Mass update the Pay Step and State Step fields for all employees tied to a salary table. This
allows preliminary payroll data to be sent to Budget as a starting point.

Consider repeating this step as follows for each pay type to ensure that all employees are
incremented properly.
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* For Pay Type 1 (Contracted Employees), increment once for both the Pay Step and State
Step.

* For Pay Type 2 (Non-contracted Employees), only increment the Pay Step for these
employees as they are not subject to Stat Min making the State Step unnecessary.

* If needed, repeat for Pay Type 3 (Hourly Employees).

Payroll > Utilities > Mass Update > Employee

This utility is used to update employee data for a number of employees at a single time.
Employee data may be updated by a variety of criteria including pay type, pay grade,
primary campus, and pay frequency. The Employee tab allows users to reset, increment, or
modify employee data. The data that may be altered includes the number of annual
payments, number of days employed, contract begin date, and number of years of local
experience. Once employee data is altered using this page, changes are reflected in the
individual employee records.

Year M Fred
Parameting
Py Status
B active (Cinactive () Both Primary Cormgas | o v| Paoipae [ )i
Py Campis [t o | F Monthly NTR v
Py Type: All - Cortrsct Hgn Date: | ~|  Satsry Concept (Al ) -
kb Code (Al ~ Contract End Date: | =) ewman: [ =
el Coga, AL hd ComtractMonths: [ | Eployeetib | i
Pary Girate | ]
Prior ¥r Emp Dt [ 01-06- 2025
DEDUCTIONS LEAVE EMPLOYEE EXTRA DUTY OB COOE SALARY CALCULATION
Rezat Increment L
(] Py Seatus [ s ay Step [3f]) Pay Step From To
(] Dock Rate ) Contract Begin Date [7) Stae St ConvsrErdlie [ - |- |
oyt Elg =[] Contract End Date [] Limit 20 M Days Emplad [ g [ q
() & of Monhs in Contract Koot Chicw Contract Dars: 000 TRS - »[000 TRS - |
o | [ Comtract Days Faryull Date L= )
| (]l Local Contract Days
[ Pavatt Cate
(O] Pay Graoe
[ 1Y 7] Local Schwcicde
C 13) [T Max D
[ u] ] Hewosy
Lﬂl [ weiey Hers Sehea

The following image is an example of mass updating the Accrual Code for teachers.

o The accrual code may vary by LEA.
o The actual Contract Begin Date and Contract End Date and Payoff Date may vary by

LEA.
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Wear: I Feogumay |
Parwmeters. ————
S -
Wt ()tnsctaee () Both Primary Compua. | A1) v Payelt Cata I:
Py Campus | &u * | Fevroy [F Pty v -
Py Type [ v Coraract Begn Dute | ¥ | Sulary Concept [A1 -
il fuds *‘“1 = " Cortract End Date | ol ey . - -]
e S Y - R v
o - Eadmg e | ] L
Proe 1 (g Gate: [ 00-00- 000
DEDUCTROMS  LEAVE ﬂ ¥ OEOO0E  SALANY CALOULATION
- R Ly Execute
= (0 e v e O fu_
- [ cosndar . [ Cantrast Begin Date
(] Gt e Bt fai-a3-29 (] taste fasp Cantract End Dt [
(5] ommract ot Cuats [ vt 20 Mt Dy Bt r K| C|
| ] Mew D vt I G| (] Vool s Exprerce sofMonthiinComaa| | [
E:‘__::I'_’:':::“" [ % o Mt i Cstract arploymaint Duin < 12 Cantract Days 00 T - [ 000 TRS - )
[ 755 Sttt Dot Code o1 Corernction [
[0 T mtwmtr Pias .-E[__I vl Contract Days [
Pt e
S o) (0] Paw s [
[ Asvuat Bawpment=. 0[] Lot Seraiats [
[zl hemsimeng Payments Ij] (0 Man D
[ W arrusl Paymerts 5 (] ey
() WC Remaring Paymerts. [ 1) ) Wik e
O Click Execute. The Employee Mass Update Report is displayed.
[ Process ] [ Cancel ]
S i 2
Dabe Fun: Empiloyss Mass Update Report
Coty Dist: 150 Pagec1 of &
Frequency: F
Emp Mbe Employes Name Column From To
000021 Contract Began Date - Reset 09-02-2025 08-03-2026
Contract End Date - Resst 05-22-2026 05-23-2027
Payedf Date - Reset 08-15-20256 08-23-2027
Remaining Payments 00 12
WC Remaining Payments 00 n
000042 Confract Began Date - Reset 08-08-2025 08-03-2026
Contract End Date - Resst 05-22-2026 05-23-2027
Payolf Date - Reset 08-15-2026 08-23-2027
Remaining Payments o7 12
WC Remaining Payments 0 10
000050 Contract Begin Date - Reset 08-12-2025 08-03-2026
Confract End Diate - Reset 05-21-2026 05-23-2027
Payolf Date - Reset 08-15-2026 08-23-2027
Ramaining Paymants 07 b 2
WC Remaining Payments 00 0

o If the information is valid, click Process.

o If information is missing or needs to be changes, click Cancel.

The Mass Undate process completed successiully.

* Ok
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16. Mass update various employee fields.
Mass update various employee fields
Log on to the next year pay frequency.

Use the Mass Update utility to update employee data in preparation for the new school year.
This utility allows you to quickly and easily mass change data resulting in minimal manual
changes to individual employee records with less possibility of manual entry errors.

pay frequency to which you are logged on as you may be changing back and forth

0 CAUTION: To avoid entering data in an incorrect pay frequency, be mindful of the
between the current year and next year's pay frequencies for several months.

Mass update data as needed. The following fields are commonly updated.

* Fiscal Year - If some employees should not be incremented to the next fiscal year, repeat
this step only selecting specific employees and mass update them back to the correct fiscal
year. An example of this may include those paid with Elementary and Secondary School
Emergency Relief (ESSER) Programs.

* Contract Begin Date

* Contract End Date

* Nbr Days Empld

* # of Months in Contract

* Payoff Date

* (Number of) Annual Payments

* (Number of) Remaining Payments

* (Number of) WC Annual Payments

* (Number of) WC Remaining Payments

Payroll > Utilities > Mass Update > Employee

This utility is used to update employee data for a number of employees at a single time.
Employee data may be updated by a variety of criteria including pay type, pay grade,
primary campus, and pay frequency. The Employee tab allows users to reset, increment, or
modify employee data. The data that may be altered includes the number of annual
payments, number of days employed, contract begin date, and number of years of local
experience. Once employee data is altered using this page, changes are reflected in the
individual employee records.
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O Under Parameters, select the employees whose employee data is to be changed.

IZ: :ﬁl TIP: Prior to processing a mass update, capture a screenshot of the parameters
&  used for future reference.

Note: Never use the Reset, Increment, and Modify options at the same time.

Example of Reset:
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Example of Increment:
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O The first run is to update the contract dates, but not increment any pay steps. Complete only
the fields under Modify.

o Under Modify, complete the applicable fields.

o In the Prior Year Employment Date field, type today's date in the MM-DD-YYYY format
and select the pay frequency. This changes the contract dates for all employees,
regardless of the date they came to work for the LEA.

Note: The Prior Year Employment Date field uses the date in the Latest Re-Employ
Date field on the Personnel > Maintenance > Employment Info. If this date is blank or
contains zeros, it uses the date in the Original Emp. Date field. If no date exists in either
field, the employee is not updated.
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O The second run is for pay purposes to update all employees with one year of earned
experience.

o In the Prior Year Employment Date field, enter a date in January (i.e., 01-XX-XXXX)
that represents the maximum number of days required for the employee to have earned
a pay step advance (e.g., 90 days).

o This run does not include any employees hired after that date because they should not
receive a step advance for pay purposes but consult your LEA's policy.

o Under Increment, complete only the Pay Step and State Step fields.
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CAUTION: Do not update any Experience fields at this time. Experience should
v not be updated until after the service records have been extracted and saved.
0 Once the service records are complete, you can update records in either the
current year or the next year. It is important not to forget this step as it must be
completed prior to PEIMS reporting in October.

O Click Execute. A preview report is displayed. Review the report.

O Click Process. A message is displayed indicating that the process was completed
successfully. Or, click Cancel to return to the Mass Update page.

O Use the Extra Duty tab to change employee extra duty assignments that display on the Pay
Info tab.

O Run the Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra
Duty Report by code before performing the extra duty mass updates. Once you update your
changes, run the HRS6550 report in the NYR frequency to verify that the changes are correct.
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17. Mass update extra duty remaining payments.
Mass update extra duty remaining payments
Log on to the next year pay frequency.

Use the Mass Update utility to update employee data in preparation for the new school year.
This utility allows you to quickly and easily mass change data resulting in minimal manual
changes to individual employee records with less possibility of manual entry errors.

Mass update the remaining payments on all extra duties for applicable employees.

It is recommended to update the number of remaining payments for extra duties to ensure
they are fully budgeted for.

W»%. CAUTION: To avoid entering data in an incorrect pay frequency, be mindful of the
pay frequency to which you are logged on as you may be changing back and forth
between the current year and next year's pay frequencies for several months.

Payroll > Utilities > Mass Update > Extra Duty

This utility is used to update extra duty assignments for a number of employees at a single
time. Extra duty data may be updated by a variety of criteria including pay type, pay grade,
primary campus, and pay frequency. The Extra Duty tab allows users to add, change, and
delete extra duty codes as well as alter the existing dollar amounts associated with the extra
duty assignments. Once extra duty assignments are changed or deleted using this page,
modifications are reflected in the individual extra duty records.

Year: M Frequency: F
Parameters
Pary Status: =
® Active () nactive () Bath Primary Campus: (A1 w | Payolf Date: [ ]E
_ Pay Campus: Al “|  Frequency: [F Monthly NYR

Pary Ty AL gl Contract Begin Date: | ¥ Sslary Concept: | ALl
Job Code: (AL - Contract End Date: | *|  Extract ID: b
Accrual Code: | All bt Contract Months: | Emploveshbe: [ g
Pay Grade: L ]
Prior Yr Emp Date:| - -

DEDUCTIONS LEAVE EMPLOYEE EXTRA DUTY 0B CODE SALARY CALCULATION

Method Change
il 2 Dut D B
() Change Extra Duty Code to Ancther Code 1 Extra Duty C“"'“‘“1 :
Amoant: o]
W Change Existing Extra Duty Code Information ] N 00
Remain Amt: 0o

J

———_

() Detete Extra Duty Code from Emplovess

() Add Extra Duty Code to Employees
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O Under Parameters, select the employees and records to be copied to the current year.
TIP: Prior to processing a mass update, capture a screenshot of the parameters used for future
reference.

O Under Method, select the extra duty changes to be implemented.
O Complete the Remain Pymts field under Change Existing Extra Duty Code Information.

O Click Populate Extra Duty Code Description to update the Amount field when a different
extra duty code is selected.

O Click Execute. A preview report is displayed. Review the report.

O Click Process to accept the changes and continue. Or, click Cancel to return to the Mass
Update page.

18. Generate the Mass Account Code Comparison Report.
Generate the Account Code Comparison Report
Log on to the next year pay frequency.

Generate the following report before calculating salaries.

Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison - This
report is used to verify the distribution codes from the master distribution page against the
account codes in Budget.

I Preview ‘ l POF ‘
Payroll Information Reports HRSE000 - Account Code Comparison
HRS1250 - Employee Data Listing ;
HES1E - Employ 52 Info }
HE’.E%U En uiaw.&\ala-v nformation Parameter Description Value
HE: - A ind e Comparison
HRS6050 - Contract Balance Variance Report 5
HRSE150 - Employee Payroll Listing o e
HAS6400 - Salary Verification Aepart Include Reports (Select From List] ;
HESE450 - Health Insyrance Coverage |
HRSE650 - CYR/NYR Salary Comparison From Date (MMDDYYYY) 090120°
To Date (MMDDYYYY) [pezizg Include Reports (x]
Pay Status Active [A], Inactive (I}, or blank for ALL l [:I Tiansaction File
Pay Type 1-4. or blank for ALL ': @ Distribution File
Select Pay Campus{es). or blank for ALL |
Select Primary Campus(es), or blank for ALL l [ K J[ Cancel l
Select Employee(s), or blank for ALL | —

If there are account codes displayed on this report, these codes should be set up in Budget
or changed.
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4 »
Date Run: Payroll Account Code Comparison Program: HRSE0]
Cnity Dist: ISD Page: 1 of 1
Frequency: F
Aceount Codes in Distribution that DO NOT EXIST in Budget
Alphabetic List
Account Code Emp Nbr Employee Name Job Code
199-11-6119.00-001-511000 000041 b 0606 - ELEMENTARY TEACHER
199-11-6119.00-001-536000 0806 - ELEMENTARY TEACHER
199-34-5129.00-599-553000 XTRA - Extra Duty
The desired outcome of this report is a report heading with no account codes listed.
Date Rurn: Payrell Acoount Code Comparizon Program: HRS6000
Cnity Dist: 150 Page: 1 of 1
Fragquency: F

19. Mass update salary calculations.
Mass update salary calculations
Log on to the next year pay frequency.
Payroll > Utilities > Mass Update > Salary Calculation

Perform salary calculations if you are using salary tables. This tab is used to automatically
calculate salaries for active employees (pay status 1) that are linked to the salary tables. You
can quickly calculate salaries and automatically update important fields in the employee record.

DECALCTIONS LEAVE EMPLOYEE EXTRADUTY  JOBCODE  SALARY CALCULATION

TIP: Salary calculations should not be done multiple times for an employee using
£  the midpoint table.

A report provides a listing of errors prior to completing the process. Clear all errors and perform
the calculations as often as necessary. All errors should be cleared before continuing. If
employee errors are encountered, the listed employees are not updated. If the employee has
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multiple jobs and one of those jobs does not have all or part of the salary table information
selected on the Job Info tab, errors are displayed and updates are not processed. When
calculations are performed on one concept and the employee has multiple concepts, errors are
displayed if any of the other concepts are incomplete and updates are not processed.

The system automatically uses the new contract amount and distributes it among the
employees' master distribution records based on the existing percentage. The new amount
displays regardless of the option selected in the Distributions Built by Amt % field on the
Payroll or Personnel > Tables > District HR Options. Manual modifications may be necessary to
employees' salary distribution codes, amounts, and/or percentages after performing salary
calculations.

O The following fields must be completed on the Job Info tab for pay type 1, 2, and 3
employees:

o Pay Grade

o Step

o Max Days - If the Max Days field is not populated, salary calculations will only process if
the field is not linked to the Annual Salary Concept. If the field is linked to the Annual
Salary Concept, this field must be populated to run salary calculations.

o Begin Date

o End Date

o The OVTM Rate field and the # of Days Employed field are calculated when the OVTM
flag and Calendar Code fields are populated on the Job Info tab.

o If the State Step field is populated on the Job Info tab, the amount from the state
minimum salary table is entered in the State Min Salary field.

CAUTION: The State Min Salary field is calculated by multiplying either the

, State Min Days or the # of Days Employed by the appropriate daily rate from
the state minimum salary table for all pay types that have state min. The %
Assigned field in the State Info section on the Job Info tab is also considered in
this calculation. The State Min Salary field should be checked closely and
manually updated, if necessary, after performing salary calculations.

o If an employee has an extra duty account type G on the Pay Info tab, it is added to the
Total field for the contract on the primary job.

o If an employee has a business allowance account type T or B amount with remaining
payments and/or an extra duty account type S amount with remaining payments and
distribution codes totaling 100% exists in the master distribution record for the account
type, the appropriate distribution records are updated.

o If the # of Annual Payments and Contract Total fields are greater than zero, the Pay
Rate field is calculated by dividing the Contract Total by the # of Annual Payments.
If the # of Annual Payments and/or Contract Total are not populated, the Pay Rate is
not calculated.

o If the # of Days Empld and Contract Total fields are greater than zero, the Daily Rate
of Pay field is calculated by dividing the Contract Total by the # of Days Employed. If
the # of Days Employed and/or Contract Total are not populated, the Daily Rate of
Pay is not calculated.

o Other fields that are updated on the Job Info tab are:
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= Accrual Rate - If the accrual code exists and the # of Days Empld and Contract
Total fields are greater than zero, the Accrual Rate field is calculated by dividing
the Contract Total by the # of Days Employed. The amount is rounded to three
decimal places.
= Contract Total and Balance
» Pay type 3 employee salaries are calculated based on the hourly/daily or
midpoint salary table information. If the local annual table is used, errors are
displayed when performing mass salary calculations.
e When using the hourly/daily salary schedule, calculations are based on the
Hrs Per Day field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.
¢ When using the midpoint salary schedule, calculations are based on the
Midpoint field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.
e If the # of Days Employed field is not populated, the Contract Total and
Balance fields are not calculated.

o If not performing mass salary calculations for hourly employees, manually update the
Contract Total on the Job Info tab and distribution information. This salary information is
extracted to Budget and used for PEIMS reporting.

o On the Job Info tab, there is a Calculate button, salary calculations can be done for an
individual rather than doing salary calculations in Mass Update for groups of employees.
The Calculate button on the Job Info tab will render the same results as doing the Mass
Update salary calculations.

o The Automatically Compute fields on the District HR Options page assist in manually
updating employees. By using this feature, the pay rate, daily rate, dock rate, accrual
rate, and overtime rate can all be automatically calculated when the annual contract and
days employed are entered on the Job Info tab.

Midpoint Calculation Examples

%] P kg P P Max | Mid I
Pay Grade Pay Type Minimum Maximum Midpnint ax Parcent Pay W Parcant Pay i IncfUec id Inc/Dac Hour
Increase Increase Armount Armount

1 Contracted employes 203.680 305.530 254 605 [

2.00 _.] 0.000 S.092 2.00

J |
ntracted employes 224040 336070 280055 ( 0000) | 2000) 0,000 6601  B.OD

20. Manually add or update salary information.
Manually add or update salary information

Manually add or update salary information for those employees not tied to salary tables. For
example, most often, administrators such as the Superintendent or Principal.

* Manually enter an estimated annual salary amount for pay type 3 (Hourly) employees in order
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to budget for these employees. * Add new employees as information becomes available.
Payroll

o Pay Info - This tab is not shared between the current year and next year records.

O Make the necessary changes to the extra duty supplements and verify the changes
using the Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification
Report.

O Updates to the extra duty table do not automatically update the extra duty data on the
Pay Info tab.

* Click Yes to update both the current year and next year records.
* Click No to update only the next year records.

This also occurs when changes are made in the current year records and next year
records exist.

o Job Info - This tab is not shared between the current year and next year records.

O For new employees, a generic job is displayed on the Job Info tab and this job can be
modified as needed. The following fields must be completed prior to saving:
* Primary Campus
% Assigned
# of Days Emplid
TRS Member Position
Begin Date
End Date

Notes:

o The following data should be entered before performing automatic salary calculations:
= Pay Grade
= Step
= Sched (if applicable)
= Max Days
= State Step
= State Min Days
= TRS Year - This field should be selected if the employee has a nonstandard
contract.
» Accrual Codes
= W/C Code
= State Minimum Salary % Assigned - Verify this field for employees whose # of
Days Employed field does not match the State Min Days field on the Job Info tab
for the primary job and adjust accordingly.
= Distribution information
o Distributions - This tab is not shared between the current year and next year records.

O If a contract amount is not entered on the Job Info tab, no amount or percentage is
required before saving the record. If the account code does not exist in Budget, it cannot
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be selected from the account code drop-down list.

O A distribution code must exist for each job to be updated with salary calculations. When
calculations are performed, amounts are updated based on the existing distribution
percentages.

O Verify Expense 373 designations for applicable employees who are subject to Stat Min
calculations.

o Deductions - This tab is not shared between the current year and next year records.

Exception: When changes to an existing employee's deduction information is saved, a
message is displayed asking if the current year records should be updated.

If the Remain Pymts field is set to 99, it will not decrement each time a payroll is
processed.

Be sure to add an Emplr Contrib (Employer Contribution) amount for vacancies/new
employees to avoid an understated budget.

Update the garnishment amounts as there may be changes to the salary amounts for the
upcoming year and the garnishment amounts are based on salary percentages.

* Click Yes to update both the current year and next year records.
* Click No to update only the next year records.

This also occurs when changes are made in the current year records and next year
records exist.

* Click Yes to update both the current year and next year records.
* Click No to update only the current year records.

21. Verify TRS fields.

Verify TRS fields
Payroll > Reports > User Created Reports > HR Report

Generate a user-created report to verify that the following TRS fields are accurate for all
employees. You can use the sort/filter options to assist in the verification process. If corrections
are needed, use the corresponding pages to make changes.

TRS Reporting Requirements

o ALL employees are reported.
o Retired employees are only reported on the ER record.
o A contract Begin and End Date is required for ALL employees.
Required Information ASCENDER Business Page
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22.

The FTE Hours (full-time equivalent) is required for the
ED record if 30 hours or more.

Personnel > Tables > Job/Contract >
Job Codes

The Days Worked or scheduled is required for the RP
record. This data is retrieved from either the school
calendar or TR calendar.

Personnel > Tables > Workday
Calendars

The Employment Type is required for the ED record.

Personnel > Maintenance >
Employment Info

The TRS Status (TRS membership eligibility flag) is
required for the ED record.

Payroll > Maintenance > Staff Job/Pay
Data > Pay Info

A TRS Member Pos (position) Code is required for all
employees (including substitutes).

The Wkly Hrs. Sched (hours scheduled) is required for
the RP record.

Payroll > Maintenance > Staff Job/Pay
Data > Job Info

The Retiree Employment Type is required for the ER

record.

Personnel > Maintenance >
Employment Info

Verify salary calculations.

Verify salary calculations

Select and run the applicable reports to verify the salary calculations:

o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - This report
provides a list of employees by pay campus. This is a good report to give to principals and
directors to verify employees assigned to their campus or department without sharing

pay information.

o Payroll or Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing -
This report provides detailed information about demographics, salary,
TRS/Calendar/School YTD, leave, deductions, and account distribution codes.

o Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance Variance
Report - This report will print exceptions for contracted (pay type 1) and non-contract
(pay type 2) employees when the contract balance does not equal the Pay Rate times

the # of Remaining Payments.

o Payroll > Reports > Payroll Information Reports > HRS6150 - Employee Payroll Listing -
This report provides detailed information about pay status, campus code, pay type,
marital status, number exemptions, months/days in contract, annual contract amount,
monthly/daily rate of pay, and the first distribution line from the master distribution

record.

o Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification Report -
This report can be used to verify that next year salary calculations have been correctly

run before copying next year to current year.

o Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison -
The report is an error listing. For current year, the report identifies account codes in the
payroll process and verifies that these account codes exist in Finance. If a code entered in
the payroll process is not located in the chart of accounts, the account number, social
security number, and name of the employee are printed on the report. For next year, the
report identifies account codes on the Budget Data page of the Budget application.

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. Users
can sort the listing by name, campus, or extra duty code. The Include Distribution
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Account Codes parameter allows the user to include S-type distributions for those
employees selected.

o Payroll or Personnel > Reports > Payroll Information Reports > HRS6650 - CYR/NRY Salary
Comparison - This report provides a salary comparison for employees with pay type 1 and
pay type 2 jobs. The report indicates employee information and job information for both
the current year and next year to allow an easy comparison of salaries between the data.

o Payroll or Personnel > Reports > User Created Reports > HR Report - Run user created
reports as defined by the user.

23. Use Addendum sheets to verify data.
Use Addendum sheets to verify data

Payroll > Utilities > Payroll Simulation > Addendum

Use the Addendum created when using the Payroll Simulation utility to verify data as it lists all
jobs separately, as well as business allowances, extra duty, etc.

Only active employees (pay status 1) are considered in this process. The Addendum sheets can
be used to explain pay to employees and as a contract support document for applicable
employees to sign & date.

Personnel > Reports > Payroll Information Reports > Employee Salary Information
o If this report is generated from next year payroll files, leave information is excluded.
o If this report is generated from current year payroll files, leave information is included.
24. Perform a "test payroll".
Perform "test payroll"
Log on to the next year pay frequency.
Payroll > Utilities > Pre-Edit Payroll Data

Run this utility to perform what could be called a “test payroll” for employees that meet the
selected parameters.

It is a partial run of calculations and it does not use transmittals or leave files. This utility can be
run in either the current year or next year.

An unprocessed pay date is required to be entered. If there are no unprocessed pay dates in the
Pay Dates table, enter a pay date for the next month. For example, August payroll has been
processed and pay dates for the new school year have not been entered yet.

Note: This utility should be run prior to creating your budget extract or before copying the
next year to the current year. This utility creates a report that displays errors on each
employee. The report is sorted by employee number order and provides error messages
that are easy to understand so that corrections can be made prior to extracting for budget.
Remember, if changes are made to the employee records, calculations need to be run
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again.

25. Perform staff benefits update.
Perform staff benefits update
Log on to the next year pay frequency.
Payroll > Utilities > Employee Benefits Interface > Import Annual File

Perform the employee benefits update and import process.
Year ! Frequency: F
EXTRACT IMPOAT ANMUAL FILE IMPORT CHANGES OMNLY

Year Selection

O Under Year Selection, select one of the following:

o Current Year

o Next Year
Active Employees |Select to base the selected pay frequency for the records on the
Only highest pay frequency in which the employee is active.
Deduction Import |[Click Browse, and then select the folder to which a copy of the
Path deductions is to be imported. Click OK to select the folder or Cancel to
close the dialog box without processing.

O Click Execute to start the import process.

o In the application dialog box, verify the path of the import, and click Yes to continue the
import or No to return to the import dialog box.

o In the archive password dialog box, type a password for this imported file. Click OK.

o The files are imported, and a message is displayed indicating the import process
completed successfully. Click OK.

If any errors are encountered during the import process, an error report is displayed. If there
are no errors, the error report is not displayed.

If no errors are encountered during the import process, or you clicked Continue from the error
report, the import report is displayed.

Review the report.
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O Click Continue to proceed.

O If you click Process, a message is displayed indicating that the data was imported. Click OK.

26. Extract payroll account codes.
Extract payroll account codes

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Payroll Account Codes

Before interfacing the payroll to the budget, verify the following:

o Are all new employees in the system?

o Are all employees active that are to be extracted to budget?

o Are all Staff/Job Pay data tabs updated and complete for new and existing employees?

o Does the next fiscal year in distributions match the budget fiscal year?

o Are all deductions updated?

o Are all extra duty stipends updated?

o Since the next year payroll budget calculations use the s-type extra duty remaining
amounts, verify that these amounts have been updated.

Run this utility to extract payroll account codes for specific active (pay status 1) employees who
are in the next year payroll. The resulting extract is used to transfer this information to the
budget. This process can be repeated as often as necessary.

EXTRALT PAYROLL ACCOUNT CODES EXTRALT REPOHTS INTERFACE TO BUDGET

it Yo Fracuency

O« Bty E - Semimaontrly [F] F« Monthity [ Eatlue TRE On-Dehald Caloulations  THS O Behald Expenditere Acourt }ux‘m]u.ﬁn-x-un

Fary Camgrs Prisnary Campus .
Moty emploves deductions remaining pyments:  Frequency Dc [ 26] B (24 Ij

Enber the Starting Acoounting Period for the Finance Fiscal Tear ‘_‘.‘"' E]Q - SEptEmbEr LEA
07 - July LEA
Emoby  Ereousnoy Liak Barme [Eii Nama Select  Emohbr  Fressncy Last Mame First Nama

ANDREATTA AMANOA Mo Rowe
ASTELLD AMANDA
BARRON AMBER
BATTILL AMBLR
BUESTTL ANGELA

BN ANALICA
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BUNMELL BETHANY
CARTER BREMNIDA,

CASON BREMDA,
CASTRG BRrali,

DODD00O00000D00 §
o
$

F
F
F
F
o
F
Q0050 F BRASHEAR ALHEY
E
[
F
F
F
F

CLFTON BROOKLYN

O If applicable, select Exclude TRS On-Behalf Calculations.

O If you interface the on-behalf expenditures (6144) into Budget, manually input the revenue
for the on-behalf account codes (5831).
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27. Verify Extract Reports tab.
Verify Extract Reports tab
Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Reports

Use the reports to verify the accuracy and validity of the employees, accounts, and amounts.

Wi Fragusnty: F

EXTRACT PAYROLL ACCOUNT CODES  EXTRACT REPORTS  IMTERFACE TO BUDWGET

Mput Visar Payoll Extract Reports
Gen Rpt Repot St Diptions St Orde
D Hawt Tesr Payrell Ergloves Dafintekion  Alpha (A, Pay Camgus [C1 Primary Cergus [P} [:I
(] et Yesar Payroll Acocant Destritatorn Fund [F], Organiation [ I:l

Pay special attention to the employee count to verify that the correct number of employees are
extracted and match the count on the Next Year Payroll Employee Distribution Report.

Diate Run: Nt Yiear Payroll Employee Distribution Program:  HRS9960
Cnty Diist: B0 Page: 1 ol n
Fr EmpMNbr Empioyes Name TEA TRS On
Account Code Typ WIC 373 Gn Pa% Amounit FICA Medicare  Insurance Contlt Wi Comp  Behad  Unemp TRS  TRS Care Dop Core
frenmnnn [ ) ., ) (--6142-<) (-B5142-2) [+-5143-2) (--614d-2) [=6145) (ruveaodfldBecnnnnd ) [+-B5148.)
Arn | HSA [ DefComp | Emplr Misc
[rommemmne e B4 )
F 000400 ANDREWS. JULIE PayCmp001 FICA M TRSS: 1 Unemp: Y Day%: 10000 ExpDist Exp Tt Deg: O
199-41-6129.00-750-699000 G C N 100,000 2252976 o J24.07 576 00 00 183055 00 92335 00 o0
o 00 o
Cafe Ame:  180.24 2581549 Empioyee Totaly: 2252076 00 207 576 00 00 1EMSE 00 92935 o0 o0
00 00 o0
Prim Job Code PetAsgn  Prim Camp Typ Gty At Sid Pay Begin D State Min Dirys MoContr Py Grd WIC Cd Accris Cd
Extra Duty Cd SiMin Salary Dl Pay Rate Locsl Nor Days Empld  AnnPymis  Step WIC Pymis  Accrue Rate
Wholly Sep
Y (400 - SECRETARY 10000 o 2 252978 187748 07-23-2024 187 w = A
o 136544 25297 165 12 Q 136 544
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Ded EmpAmt Pmt Cof Empr Fac TEAF Ded EmpAmi Pmt Cof Empr Foc TEAF Ded EmpAmt Pmt Caf Empr Fac TEAF
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F 000446 APPLEGATE, CHRISTINA ELAINE PayCmp001 FICA: M TRSS: 1 Unemp: ¥ Day%: 10000 ExpDist Exp Tot: Deg: O
19-11E12300:000611000 G A N 100,000 IT4TD4R 0 333 576 0 12934 358w {04] 103044 00 00
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MNext Year Payroll Account Distribution

Date Run:

Cniy Dist:

Sorn Order: Fund
Account Code Amount
199-11-6119.00-001-611000 TEACHER SALARIES, GEN INSTRUCT
F 000443 22.112.86
E 000461 13.142.50
F 000450 3205415
F 000453 20.050.00
F 000462 33.298.50
F 000372 26.771.50
E 000435 41.090.34
E 000452 2.000.01
F 000445 875.00
F 000460 750.00
F 000218 35.861.10
F 000382 29.936.65

Totak: 257.942.61
199-11-6119.00-001-621000 TEACHER SALARY
F 000450 2.700.84
F 000348 850.00
Totalk 3,550.84

199-11-6119.00-001-622000 PROFESSIONAL SALARIES
F 000443 268415
F 000452 500.01
F 000445 61.498.34

Program: HRS9970
Page: 10of 22

28. (If necessary) Perform another extract and interface to Budget.

(If necessary) Perform another extract and interface to Budget

If changes are made to employee salary information, employees are added, employees are
inactivated, or termination dates are entered, perform another extract and interface those new

changes to Budget.

Note: Updates to the budget will replace the existing amounts for those account
distribution codes that match the accounts in Budget. If an account distribution code no
longer exists in payroll when interfaced to Budget (after previous interfaces), the account
code is not changed or removed in Budget. You must manually modify the budget for those
account codes. This also applies to those amounts in the budget that have been manually
modified after the initial interface from payroll. If the budget account is not locked and the
change needs to be retained for budget purposes, all manual modifications need to be

made again.

29. Interface to Budget.

Interface to Budget

Payroll > Next Year > Interface NY Payroll to NY Budget > Interface to Budget
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EXTRACT PAYROLL ACCOUNT CODES EXTRACT REPORTS INTERFACE TO BUDGET

Mest Year Payroll Round account totals to the nearest dollar
D Use Budget Crosswalk tables

(®) Mext ¥r Recommend

o Mext Yr Approved

If all of the information is correct:
O Under Next Year Payroll, select one of the following columns to be updated in Budget:

o Next Yr Recommend
o Next Yr Approved

O Click Interface. This process can be repeated as often as necessary until the Board approves
the budget. For each run, the Next Year Budget amount is replaced. If the budget lock flag is
set on an account, the budget amount is not replaced.

If distributions or employees are changed after the first calculations are interfaced, you
may be required to log back on to the current pay frequency and use the Payroll > Next
Year > Copy CYR Tables to NYR > Clear Next Year Tables tab with the Clear NY Payroll
Budget Only option selected to recalculate and interface the new changes back to the
next year frequency.

Contact your regional ESC consultant if you need additional assistance.
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